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1. はじめに Introduction 
 
世界的に、2つの周波数バンド 5.25 - 5.35 GHz, 5.47 - 5.725 GHzは、様々なレーダシステム
に使用され、免許不要のWLAN (IEEE802.11a)デバイスに許可されています。この周波数バン
ド再利用の要件は DFS (Dynamic Frequency Selection)と呼ばれます。
DFSを要求するシステムは、レーダシステムに干渉することを回避できる必要があります。
要件とテストパターンを定義する異なるスタンダードが世界的に存在します。

• US: FCC06-96 
• EU: ETSI EN 301 893 (5 GHz), ETSI EN 302 502 (5.8 GHz) 
• Japan: TELEC-T403 

R&S パルスシーケンサ ソフトウェアを使用することで、DFSレーダテスト信号用の複雑なパルス
パターンを簡単に発生することができます。

このマニュアルは、TELECスタンダードの要件に対処します。R&S K6 パルスシーケンサ ソフト
ウェアオプション付き R&Sベクトルシグナルジェネレータ(VSG)を使用して、どのようにテスト信
号を生成できるかを説明します。

R&S パルスシーケンサ ソフトウェアは、DFSスタンダード用に予め定義されたプロジェクトファイ
ル付きスタンドアローン PCベースソフトウェアです。要求された全ての波形を簡単に生成できま
す。 

Worldwide, the two frequency bands 5.25 - 5.35 GHz and 5.47 - 5.725 GHz are used by 
various radar systems and in addition, are allocated to unlicensed WLAN devices. A 
requirement arising from this frequency band reuse is a method called DFS which stands 
for Dynamic Frequency Selection. 
A system that requires DFS needs to be capable of avoiding interfering with radar systems. 
Different standards documents exist worldwide that define requirements and test patterns. 

• US: FCC06-96 
• EU: ETSI EN 301 893 (5 GHz), ETSI EN 302 502 (5.8 GHz) 
• Japan: TELEC-T403 

The R&S Pulse Sequencer software allows the easy generation of complex pulses and 
pulse patterns for DFS radar test signals. 
This manual deals with the requirements set in the TELEC standard. It describes how the 
test signals can be generated using a R&S Vector Signal Generator (VSG) with the R&S 
K6 Pulse Sequencer Software option. 
The R&S Pulse Sequencer Software comes as a stand alone PC based software with 
preconfigured project files for DFS and other standards. It simplifies the generation of all 
required waveforms. 
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2. VSGオプション VSG Options 
 
• SMU200A  Vector Signal Generator

SMU-B106  100 kHz to 6 GHz 
SMU-B9, B10 or B11 Baseband Generator with ARB 128 MS, 64 MS, 16 MS 
SMU-B13   Baseband Main Module 
SMU-K6   Pulse Sequencer License 

 
• SMATE200A  Vector Signal Generator

SMATE-B106  100 kHz to 6 GHz 
SMATE-B9, B10 or B11 
 Baseband Generator with ARB 128 MS, 64 MS, 16 MS 
SMATE-B13  Baseband Main Module 
SMATE-K6  Pulse Sequencer License 

 
• SMJ100A   Vector Signal Generator

SMJ-B106  100 kHz to 6 GHz 
SMJ-B9, B10, B11, B50 or B51 
 Baseband Generator with ARB 128 MS, 64 MS, 16 MS 
SMU-B13   Baseband Main Module 
SMU-K6   Pulse Sequencer License 

 
• SMBV100A  Vector Signal Generator

SMBV-B106  9 kHz to 6 GHz 
SMBV-B10, B50 or B51 
 Baseband Generator with ARB 32 MS 
SMBV-B92  Removable HDD 
SMBV-K6  Pulse Sequencer License 
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3. 文献 Literature 
 
• TELEC-T403: W53/W56 Radio System Conformance Testing, V 9.3, December 1st,

2009 
• NTIA (National Telecommunications And Information Administration) DFS information 

http://ntiacsd.ntia.doc.gov/dfs/
• DFS Signal Generation Manual 

http://www2.rohde-schwarz.com/file/DFS_Manual.pdf
• R&S Pulse Sequencer Software Manual 

http://www2.rohde-schwarz.com/file/Pulse_Sequencer.pdf
• R&S SMU200A Operating Manual 

http://www2.rohde-schwarz.com/file/SMU200A_Operating_Manual_e.pdf
• R&S SMATE200A Operating Manual 

http://www2.rohde-schwarz.com/file/SMATE200A_Operating_Manual_e.pdf
• R&S SMJ100A Operating Manual 

http://www2.rohde-schwarz.com/file/SMJ100A_Operating_Manual_e.pdf
• R&S SMBV100A Operating Manual 

http://www2.rohde-schwarz.com/file/SMBV100A_Operating.pdf
• Application Note 1MA127: Overview of Tests on Radar Systems and Components 

http://www2.rohde-
schwarz.com/en/service_and_support/Downloads/download_search/?searchtype=1&d
ownloadtype=all&download_b=1&type=20&downid=4805

http://www2.rohde-schwarz.com/en/service_and_support/Downloads/download_search/?searchtype=1&downloadtype=all&download_b=1&type=20&downid=4805
http://www2.rohde-schwarz.com/en/service_and_support/Downloads/download_search/?searchtype=1&downloadtype=all&download_b=1&type=20&downid=4805
http://www2.rohde-schwarz.com/en/service_and_support/Downloads/download_search/?searchtype=1&downloadtype=all&download_b=1&type=20&downid=4805
http://www2.rohde-schwarz.com/file/SMBV100A_Operating.pdf
http://www2.rohde-schwarz.com/file/SMJ100A_Operating_Manual_e.pdf
http://www2.rohde-schwarz.com/file/SMATE200A_Operating_Manual_e.pdf
http://www2.rohde-schwarz.com/file/SMU200A_Operating_Manual_e.pdf
http://www2.rohde-schwarz.com/file/Pulse_Sequencer.pdf
http://www2.rohde-schwarz.com/file/DFS_Manual.pdf
http://ntiacsd.ntia.doc.gov/dfs/
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4. 発生する波形サイズ Generated Waveforms Size 
 
VSG要件は、主に発生する波形サイズに依存します。種々の DFSテスト信号用波形サイズをリ
ストします。波形サイズは、ARBサンプリングレートにもとづき、メガサンプル(MS)で表され、必
要最大数です。

The VSG requirements mainly depend on the size of the generated waveforms. The table 
below lists typical waveform sizes for the different DFS test signals. The listed waveform 
sizes are the maximum number that needs to be expected based on a given ARB 
sampling rate and provided in mega-samples (MS).  
 
Radar Type for Test Signal Waveform Size Sampling Rate 
W53 Static Type 1 0.8 MS 20 MHz 
W53 Static Type 2 2 MS 20 MHz 
W56 Static Type 1 0.8 MS 20 MHz 
W56 Static Type 2 0.8 MS 20 MHz 
W56 Static Type 3 2 MS 20 MHz 
W56 Varied Type 4 8 MS 20 MHz 
W56 Varied Type 5 9 MS 20 MHz 
W56 Varied Type 6 8 MS 20 MHz 
W56 FM chirp Type 1 4 MS 20 MHz 
W56 Frequency Hopping Type 1 0.6 MS 100 MHz 

5. VSGへの接続 Connecting to the VSG 
 
パルスシーケンサ ソフトウェアのインストール後の最初のステップは、VSG接続を確立すること
です。VSG接続は、波形および RFリストファイルの生成に必要です。 
PCと VSG間のリモートコントロール接続は、LANあるいは GPIBインタフェースです。

The first step after a fresh installation of the Pulse Sequencer Software is to configure the 
VSG connection. The VSG connection is required for the creation of Waveforms and RF 
List files. 
The remote control connection between PC and VSG is LAN or GPIB interface. 
 

• Instrument → Manager 
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• TCP/IPホスト名や IPアドレス、あるいは GPIBアドレスを指定
Define TCP/IP Host name or IP address, or GPIB address. 

• Add Manually 
• ターゲット VSGを選択するためにダブルクリック

Double click to select the target VSG. 
• リモート接続が確立されると、Device Informationが表示されます。

The established remote connection displays Device Information. 

• Exit 
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6. DFSプロジェクトファイルのロード Loading a DFS Project File 
 
パルス・シーケンサ ソフトウェアは、種々の DFSスタンダード用の予め定義されたプロジェクト・
ファイルを含んでいます。

プロジェクトファイルは、パルス定義、レーダテスト信号、およびスタンダードで要求される周波数

ホッピングリストを全て含んでいます。

プロジェクト・ファイルを直接編集できませんが、それらは、様々なテスト信号の生成のためにパ

ルスシーケンサ ソフトウェアを設定します。必要に応じて設定変更し、異なるファイル名でプロジ

ェクトファイルをセーブできます。

The Pulse Sequencer software contains predefined project files for the different DFS 
standards. 
The project files contain all pulse definitions, radar test signals, and frequency hopping 
lists that are required by the standard. 
The project files cannot be edited directly but they configure the Pulse Sequencer 
Software for the generation of the various test signals. It is possible for the user to alter 
settings as needed and save the modified project file under a different name. 
 

• File → Load Project 
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• 適切なファイルを選択

Select the appropriate file. → Load 
 
TELEC
Japan-TELEC-T403.prj:  TELEC-T403 
 W53 waveforms 
 W56 static type waveforms 
 W56 varied type waveforms 
Japan-TELEC-T403-Chirp.prj: TELEC-T403 
 W56 FM chirp type waveforms 
Japan-TELEC-T403-Type6.prj: TELEC-T403 
 W56 Frequency hopping type waveform and RF lists 
 
FCC
FCC0696-Type6.prj:  FCC 06-97 
 including NTIA RF hop lists 
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7. 固定パルス波形の生成 Creating the Static Type Waveforms 
 
Test Waveforms 
Radar Type 

(W53) 
Pulse Width 

[us] 
PRF 
[Hz] 

PRI 
[us] 

Pulses per 
Burst 

Burst 
Repetition 

Interval 
[s] 

Static Type 1 1 700 1,428 18 15 
Static Type 2 2.5 260 3,846 18 15 

Radar Type 
(W56) 

Pulse Width 
[us] 

PRF 
[Hz] 

PRI 
[us] 

Pulses per 
Burst 

Burst 
Repetition 

Interval 
[s] 

Static Type 1 0.5 720 1,389 18 15 
Static Type 2 1 700 1,428 18 15 
Static Type 3 2 250 4,000 18 15 

テストを始める前に全ての信号を生成することが賢明です。

It is advisable to create all signals before starting the tests. 
 

• File → Load Project 
• ‘Japan-TELEC-T403.prj’を選択

Select ‘Japan-TELEC-T403.prj’. → Load 
• ‘Multi Segment Waveform’ブランチ下の’W53 Static 1, 2’, ’W56 Static 1, 2, 3’の 1つを選
択
Select one of ’W53 Static 1, 2’, ’W56 Static 1, 2, 3’ under the ‘Multi Segment 
Waveform’ branch. 

• (Last Seg. ‘Back 1st’, Trigger Mode ‘Armed Retrigger’) 

• Start MSW build process 
 
次のステップが自動的に実行されます。

1. 波形を生成し、VSG (内部 HDD)へ転送
2. マルチセグメント波形ファイルに波形を構築
3. 設定に準じて、マルチセグメント波形で ARBをスタート

The following steps is performed automatically. 
1. Create the individual waveforms and transfer to the VSG (internal HDD) 
2. Assemble waveforms to Multi Segment Waveform file 
3. Start ARB with Multi Segment Waveform and configure according to settings 
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1 burst repetition interval 15 s長の波形ファイルが生成されます。

The waveform file of one burst repetition interval 15 s length is created. 
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8. 可変パルス波形の生成 Creating the Varied Type Waveforms 
 
Test Waveforms 
Radar Type 

(W56) 
Pulse Width 

[us] 
randomly 

(1 us steps) 

PRF 
[Hz] 

randomly 

PRI 
[us] 

randomly 
(1 us steps) 

Pulses per 
Burst 

randomly 
(step 1) 

Burst 
Repetition 

Interval 
[s] 

Varied Type 4 1 ~ 5 4,347 ~ 6,667 150 ~ 230 23 ~ 29 15 
Varied Type 5 6 ~ 10 2,000 ~ 5,000 200 ~ 500 16 ~ 18 15 
Varied Type 6 11 ~ 20 2,000 ~ 5,000 200 ~ 500 12 ~ 16 15 

テストを始める前に全ての信号を生成することが賢明です。

It is advisable to create all signals before starting the tests. 
 

• File → Load Project 
• ‘Japan-TELEC-T403.prj’を選択

Select ‘Japan-TELEC-T403.prj’. → Load 
• ‘Multi Segment Waveform’ブランチ下の’W56 Var 4, 5, 6’の 1つを選択

Select one of ’W56 Var 4, 5, 6’ under the ‘Multi Segment Waveform’ branch. 
• Last Seg. ‘Back 1st’, (Trigger Mode ‘Armed Retrigger’) 

• Start MSW build process 
 
次のステップが自動的に実行されます。

1. 波形を生成し、VSG (内部 HDD)へ転送
2. マルチセグメント波形ファイルに波形を構築
3. 設定に準じて、マルチセグメント波形で ARBをスタート

The following steps is performed automatically. 
1. Create the individual waveforms and transfer to the VSG (internal HDD) 
2. Assemble waveforms to Multi Segment Waveform file 
3. Start ARB with Multi Segment Waveform and configure according to settings 
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30 burst repetition interval 7 min 30 s長の波形ファイルが生成されます。
この Multi Segment Waveformsは要求される 30のランダムバーストを含んでいます。
バースト波形は、パルス幅、PRIおよびパルス数のランダム変数を使用します。ゆえに、‘Start 
MSW build process’の実行ごとに、異なるランダムパラメータを組み立てます。

The waveform file of one burst repetition interval 7 min 30 s length is created. 
This Multi Segment Waveforms contain the required 30 random bursts. 
The burst waveforms use random variations of the pulse width, the pulse repetition interval 
and the number of pulses. Therefore, each executing of ‘Start MSW build process’ 
assembles a different random parameter. 
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9. FMチャープ波形の生成 Creating the FM Chirp Type 
Waveforms 

 
Test Waveforms 

Radar 
Type 
(W56) 

Pulse Width 
[us] 

randomly 
(1 us steps) 

Chirp 
Deviation 

[MHz] 
Randomly 

(1 MHz 
steps) 

PRF 
[Hz] 

randomly 

PRI 
[us] 

randomly 
(1 us 
steps) 

Pulses 
per Burst 
randomly 
(step 1) 

Bursts 
randomly 
(step 1) 

FM Chirp 
Type 1 

50 ~ 100 5 ~ 20 500 ~ 
1,000 

1,000 ~ 
2,000 

1 ~ 3 15 

テストを始める前に全ての信号を生成することが賢明です。

It is advisable to create all signals before starting the tests. 
 

• File → Load Project 
• ‘Japan-TELEC-T403-Chirp.prj’を選択

Select ‘Japan-TELEC-T403-Chirp.prj’. → Load 
• ‘Multi Segment Waveform’ブランチ下の使用するバースト数エントリの 1つを選択

Select an used number of bursts entry under the ‘Multi Segment Waveform’ branch. 
• (Last Seg. ‘Blank’, Trigger Mode ‘Armed Retrigger’) 

• Start MSW build process 
 
次のステップが自動的に実行されます。

1. 波形を生成し、VSG (内部 HDD)へ転送
2. マルチセグメント波形ファイルに波形を構築
3. 設定に準じて、マルチセグメント波形で ARBをスタート
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The following steps is performed automatically. 
1. Create the individual waveforms and transfer to the VSG (internal HDD) 
2. Assemble waveforms to Multi Segment Waveform file 
3. Start ARB with Multi Segment Waveform and configure according to settings 

 

各トライアルごとに、全期間 12 sのシングル Multi-Segment波形が生成されます。
プロジェクトは、8 ~ 20バーストの波形種別を含んでいます。これらの波形はトライアル 1 ~ 13を
表わします。それ以上のトライアルでは、‘Target Name’に、既存の Multi-Segment波形種別を
コピーし、トライアル番号を変更し、容易に生成することができます。

ファイル名の一部としてトライアル番号接尾語を提供することが確実です:
• TELEC-T403-W56-<バースト数>-TRIAL-<トライアル番号>

For each trial, a single Multi-Segment waveform for a total duration of 12 s is created. 
The project contains waveform descriptions between 8 and 20 bursts. These waveforms 
represent the trials 1 through 13. Further trials can easily be created by copying an 
existing Multi-Segment waveform description and changing the trial number in the target 
name. 
It must be ensured that a valid trial number suffix is provided as part of the file name: 

• TELEC-T403-W56-<bursts>-TRIAL-<number> 
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10. 周波数ホッピング波形の生成 Creating the Frequency 
Hopping Type Waveforms 

 
Test Waveforms 

Radar Type 
(W56) 

Hop Rate 
[MHz] 

randomly 
(1 MHz steps) 

Pulse 
Width 
[us] 

PRF 
[Hz] 

Pulses 
per Hop 

Hop 
Interval 

[ms] 

Freq. Hopping Type 1 5,250 ~ 5,724 1 3,000 9 15 

テストを始める前に全ての信号と RFホップリストを生成することが賢明です。

It is advisable to create all signals and RF hop lists before starting the tests. 
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• File → Load Project 
• ‘Japan-TELEC-T403-Type6.prj’を選択

Select ‘Japan-TELEC-T403-Chirp.prj’. → Load 
• ‘Multi Segment Waveform’ブランチ下の’TELEC-T403-T6’を選択 

Select the ’TELEC-T403-T6’ under the ‘Multi Segment Waveform’ branch. 
• (Last Seg. ‘Blank’, Trigger Mode ‘Armed Retrigger’) 

• Start MSW build process 
 
次のステップが自動的に実行されます。

1. 波形を生成し、VSG (内部 HDD)へ転送
2. マルチセグメント波形ファイルに波形を構築
3. 設定に準じて、マルチセグメント波形で ARBをスタート

The following steps is performed automatically. 
1. Create the individual waveforms and transfer to the VSG (internal HDD) 
2. Assemble waveforms to Multi Segment Waveform file 
3. Start ARB with Multi Segment Waveform and configure according to settings 

 

1 burst 0.3 s長の固定パルス波形ファイルが生成されます。
波形は固定パルスであり、生成は全トライアルのために一度だけ要します。代わりに、この波形

は、トライアルごとに使用される様々な周波数リストを利用します。
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ランダムホップリストにてトライアル 1 ~ 40用リストファイルを生成する代わりに、NTIAホップリス
トを生成することが賢明です。

NTIA (National Telecommunications and Information Administration)は、次のリンク下の RF
ホップリスト例を提供します。

http://ntiacsd.ntia.doc.gov/dfs/
の'HopFreqInRlanBW.txt'ファイル

これらの 40 リストは、FCC0696-Type6プロジェクトファイル内の NTIAリスト 1 ~ 40として利用
可能です。

RF Listエディタは、周波数とレベルのペアの RF Listを含んでいるテーブルです。Limitsは、
Min – Max範囲内に入るアイテムをマークできます。これらのアイテムはリスト内で緑にマークさ
れます。

The static pulse waveform file of one burst 0.3 s length is created. 
The waveform is static and the generation is only required once for all trials. Instead, this 
waveform makes use of various frequency lists that are used for the different trials. 
It is advisable to create the NTIA hop lists, instead of a random hop list creating the list 
files for trials 1 through 40. 
The NTIA (National Telecommunications And Information Administration) provides 
example RF hop lists under the following link: 

http://ntiacsd.ntia.doc.gov/dfs/
under the file 'HopFreqInRlanBW.txt'. 

The contents of these 40 lists is available as the NTIA List 1 through 40 in the FCC0696-
Type6 project file. 
The RF List editor provides a table that contains the frequency and level pairs of the RF 
List. Limits can be set to mark items that fall within the limit range. These items are marked 
green in the list. 
 

http://ntiacsd.ntia.doc.gov/dfs/
http://ntiacsd.ntia.doc.gov/dfs/
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NTIAホップリストにてトライアル 1 ~ 40用リストファイルを生成する場合

For the NTIA hop lists creating the list files for trials 1 through 40 
 

• File → Load Project 
• ‘FCC0696-Type6.prj’を選択

Select ‘FCC0696-Type6.prj’. → Load 
• RF List下の‘NTIA List 1 ~ 40’の 1つを選択

Select one of ‘NTIA List 1 ~ 40’ under RF List 
• � Activate 
• Level Min [-**.** dBm] 
所望の出力レベル dBmを入力
Enter the desired output level dBm. 

• Level ‘Fill’ 

• Send RF list to instrument 
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ランダムホップリストにてトライアル 1 ~ 40用リストファイルを生成する場合

For random hop lists creating the list files for trials 1 through 40 
 
• ‘Random Hop List’ under RF List 
• Frequency ’Fill’ 
ランダム 100周波数ホップリストが定義されます。
The random 100 frequencies hop list is defined. 

• Level Min [-**.** dBm] 
所望の出力レベル dBmを入力
Enter the desired output level dBm. 

• Level ‘Fill’ 
• ‘Remote List File’ 
トライアル番号接尾語を加えます。
Add the trial number suffix. 

ファイル名の一部としてトライアル番号接尾語を提供することが確実です:
• TELEC-T403-Random-<トライアル番号>

It must be ensured that a valid trial number suffix is provided as part of the file name: 
• TELEC-T403-Random-<trial number> 

• Send RF list to instrument 
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11. トライアルの実施 Conducting the Trials 
 
本章は、DFSテストをどのように手動で実行するか説明します。波形、Multi Segment波形、あ
るいは RFホッピングリストが、既に VSG(内部 HDD)に転送されていることを前提とします。
操作プロシジャは、[Preset]後のデフォルト設定(下記スクリーン)から説明します。ただし、周波数
ホッピングトライアルを除く全てのトライアルでは、既に[Freq]と[Level]を設定する必要があります。

This chapter describes how the DFS tests are executed manually. It is assumed that the 
waveforms, Multi Segment Waveforms, or RF hopping lists are already transferred to the 
VSG (internal HDD). 
Operation procedure is described from the default setting after [Preset] (the following 
screen). However, [FREQ] and [LEVEL] must be set in all the trials except frequency 
hopping trials. 
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DFSテスト中のレベルまたは周波数変更において、特別な注意をする必要のある VSG特有の
機能の詳細を説明します。

これは、SMJ100A、SMU200A、SMATE200Aだけに関連します。SMBV100Aは、RF信号を
ALC中 50 dB抑圧します。
テスト中に、単一 DFSテスト信号を送り、DUTのレスポンスを観察し、検出成功で新たなチャネ
ル周波数へ変更することが要求されます。これは、レーダ信号がこの周波数上で検出された場

合、DUTがチャネルをブラックリストするに違いないからです。
ベースバンドモードが、’Execute Trigger’ボタンによるマニュアルトリガに設定される場合、ベー
スバンドがトリガ待ちで、レベルまたは周波数が変更されるとき、VSGは、正確なレベルにするた
めに内部校正信号を発生します。この校正信号は、瞬間に、設定周波数とレベルで RF出力にも
現われます。

DFSテストの場合には、DUTはこの校正信号をレーダパターンとして解釈し、利用可能チャネル
へホップするかもしれません。

この校正信号を抑圧するために、VSGには、設定 RFレベルの 40 dB以下まで RF出力を低減
する機能があります。DUTの検出しきい値以下の十分なレベルです。デフォルトでは、この機能
は無効であり、レベル抑圧を有効にすることは、VSGの RFブロックから Automatic Level 
Controlダイアログ内で設定できます。

This paragraph contains detailed information about specific VSG functions that need to be 
paid special attention for changing Level or Frequency during DFS testing. 
This is only relevant for the SMJ100A, SMU200A and SMATE200A. The SMBV100A 
suppresses the RF signal during its ALC by 50 dB. 
During manual testing, it is mostly required to send a single DFS test signal, observe the 
response of the DUT and in case of successful detection change to a new channel 
frequency. This is because the DUT must blacklist the channel if radar signals were 
detected on this frequency. 
If the baseband mode is set to a manual trigger that is issued via 'Execute Trigger' button, 
in a mode where the baseband is waiting for a trigger event and the level or frequency is 
changed, the VSG generates an internal CAL signal for correct leveling. This CAL signal 
also appears at the RF output for a short period of time and with the set frequency and 
level. 
In case of DFS testing, this CAL signal could be interpreted by the DUT as a radar pattern 
and cause another hop to the next available channel. 
In order to suppress this CAL signal, the VSG offer an function that reduces the RF output 
by 40 dB below the set RF level. This should lead to a level well below the detection 
threshold of the DUT. By default, this function is disabled and enabling the level 
suppression can be done in the Automatic Level Control dialog from the VSG RF block. 
 

• config →
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内部アッテネータの一時的変更は、内部レベルセンサに軽度の作用があるので、この機能を有

効にすることは、わずかにレベル確度を低下させます。これがデフォルトでこの機能が無効であ

る理由です。作用はわずかなので、DFSテストではレベル確度の低下を無視できます。

Enabling this function slightly decreases the level accuracy because the temporary change 
of the internal attenuator has minor effects on the internal level sensor. This is the reason 
why this function is disabled by default. Since the effect is minor, the degradation of level 
accuracy can be ignored for DFS testing. 
 



12. 固定パルスの実施 Conducting the Static Type 
 

• config → ARB 

• Load Wa
1.
23

veform 
2.

3.

4.
5.
Final.
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• d: (DATA)/telec-t403 →
W53 Type1 ~ 2 or W53 Type 1 ~ 3 → Select 

• Next Segment Mode ‘Sequencer’ 
• Sequencing List 

• Load Sequencing List 
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• d: (DATA)/telec-t403 →
W53 Type1 ~ 2 or W53 Type 1 ~ 3 → Select 

• [ESC] 
Sequencing Listを閉じる
Exit Sequencing List 

• Trigger/Marker 

• Trigger In Mode ‘Armed Retrigger’ 
• [ESC] 

Trigger/Markerを閉じる
Exit Trigger/Marker 

• ARB ‘On’ 



26

• RF ‘On’ [RF ON/OFF] 
• Execute Trigger 
 

波形の変更には、上記の全てのステップを繰り返す必要はありません。Multi Segment波形とシ
ーケンサリストをリロードすることで十分です。

For changing a waveform, it is not required to repeat all of the above steps. It is sufficient 
to reload the Multi-Segment waveform along with the sequencer list. 
 

• RF ‘Off’ [RF ON/OFF] 

• ARB ‘Off’ 
• Load Waveform 
• Sequencing List → Load Sequencing List 

• ARB ‘On’ 

• RF ‘On’ [RF ON/OFF] 
• Execute Trigger 
 



13. 可変パルスの実施 Conducting the Varied Type 
 

• config → ARB 

• Load Wa
1.
27

veform 
2.

3.

4.
5.
Final.
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• d: (DATA)/telec-t403 →
W56 Type 4 ~ 6 → Select 

• Next Segment Mode ‘Sequencer’ 
• Sequencing List 

• Load Sequencing List 
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• d: (DATA)/telec-t403 →
W53 Type 4 ~ 6 → Select 

• [ESC] 
Sequencing Listを閉じる
Exit Sequencing List 

• Trigger/Marker 

• Trigger In Mode ‘Armed Retrigger’ 
• [ESC] 

Trigger/Markerを閉じる
Exit Trigger/Marker 

• ARB ‘On’ 
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• RF ‘On’ [RF ON/OFF] 
• Execute Trigger 
 

波形の変更には、上記の全てのステップを繰り返す必要はありません。Multi Segment波形とシ
ーケンサリストをリロードすることで十分です。

For changing a waveform, it is not required to repeat all of the above steps. It is sufficient 
to reload the Multi-Segment waveform along with the sequencer list. 
 

• RF ‘Off’ [RF ON/OFF] 

• ARB ‘Off’ 
• Load Waveform 
• Sequencing List → Load Sequencing List 

• ARB ‘On’ 

• RF ‘On’ [RF ON/OFF] 
• Execute Trigger 
 



14. FMチャープパルスの実施 Conducting the FM Chirp Type 
 

• config → ARB 

• Load Wa
1.
31

veform 
2.

3.

4.
5.
Final.
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• d: (DATA)/telec-t403 →
TELEC-T403-W56-08 ~ 20-TRIAL-1 ~ * → Select 

• Next Segment Mode ‘Sequencer’ 
• Sequencing List 

• Load Sequencing List 
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• d: (DATA)/telec-t403 →
TELEC-T403-W56-08 ~ 20-TRIAL-1 ~ * → Select 

• [ESC] 
Sequencing Listを閉じる
Exit Sequencing List 

• Trigger/Marker 

• Trigger In Mode ‘Armed Retrigger’ 
• [ESC] 

Trigger/Markerを閉じる
Exit Trigger/Marker 

• ARB ‘On’ 
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• RF ‘On’ [RF ON/OFF] 
• Execute Trigger 
 

波形の変更には、上記の全てのステップを繰り返す必要はありません。Multi Segment波形とシ
ーケンサリストをリロードすることで十分です。

For changing a waveform, it is not required to repeat all of the above steps. It is sufficient 
to reload the Multi-Segment waveform along with the sequencer list. 
 

• RF ‘Off’ [RF ON/OFF] 

• ARB ‘Off’ 
• Load Waveform 
• Sequencing List → Load Sequencing List 

• ARB ‘On’ 

• RF ‘On’ [RF ON/OFF] 
• Execute Trigger 
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15. 周波数ホッピングパルスの実施 Conducting the Frequency 
Hopping Type 

 
バーストごとに波形ファイルから、次のホップに RFリストを切替える始めで、トリガパルスを発生
します。Marker 2出力を Instr. Trigger入力に接続します。
RFリストの外部トリガで、オペレーションモードを'Extern Step'に設定します。さらに、'Blank RF 
Output'を、最初のパルスの欠損回避するために無効にします。
'Blank RF Output'設定は、SMJ100A、SMU200A、SMATE200Aだけに関連します。
SMBV100Aはバーストの最初のパルスの欠損回避できません。

Each burst from the waveform file initiates a trigger pulse at the beginning that switches 
the RF list from a hop to the next one. The Marker 2 output is connected with the Instr. 
Trigger input. 
For the external triggering of the RF list, the operation mode must be set to 'Extern Step'. 
In addition the check box 'Blank RF Output' must be disabled to avoid the truncation of the 
very first pulse. 
Setting the 'Blank RF Output' is only relevant for the SMJ100A, SMU200A and 
SMATE200A. The SMBV100A cannot avoid the truncation of the first pulse from the burst. 
 

Marker 2 === BNC Cable ===> 

• config → List Mode 
• Mode ‘Extern Step’ 
• Blank RF Output (Default ON) ‘Off’ (� On) 

VSGは、周波数変更で、内部シンセサイザを再調整するので、ある程度の時間を必要とすること
を、特に注意しなければなりません。デフォルトでは、この間、不確定信号からデバイスを保護す

るために、VSGは RF出力を抑えます。新たな周波数が規定確度に収まると、信号は再びアク
ティブになります。安全のために、ブランク時間は付加マージンを含みます。



DFSテストでは、VSGで使われるデフォルトブランク時間がわずかに長く、バーストの最初のパ
ルスが欠損します。この用途で、VSGスペック内に収める難しい要求ではなく、短縮時間で周波
数がチャネル帯域幅内に収まるため、ブランク時間の短縮が可能です。 

Special care must be taken since changing the frequency requires the VSG to readjust the 
internal synthesizer and this takes a small amount of time. By default, the VSG suppresses 
any RF output during this time period to protect devices from an undefined or unwanted 
signal. The signal is activated again, once the new frequency has settled to the specified 
accuracy. For safety, an additional margin is added to the blanking time. 
For the DFS testing, the default blanking time used by the VSG is slightly too long and the 
first pulse from the burst will be truncated. Shorter blanking times are sufficient because 
the frequency will settle well within the channel bandwidth at a much shorter time and the 
tough requirement to reach the VSG specification limits is not required in this case. 
 

• config → ARB 

• Load Wa
1.
36

veform 
2.

3.

4.
5.
Final.
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• d: (DATA)/FCC-0696 →
TELEC-T403-W56-Hop → Select 

• Next Segment Mode ‘Sequencer’ 
• Sequencing List 

• Load Sequencing List 
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• d: (DATA)/FCC-0696 →
TELEC-T403-W56-Hop → Select 

• [ESC] 
Sequencing Listを閉じる
Exit Sequencing List 

• Trigger/Marker 

• Trigger In Mode ‘Armed Retrigger’ 
• [ESC] 

Trigger/Markerを閉じる
Exit Trigger/Marker 

• config → Automatic Level Control 
• Protect RF Output ‘�’



• RF ‘On’ [RF ON/OFF] config → List Mode 

• List Mode 
1.

2.
39

Data → Select List 
3.
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• d: (DATA)/FCC-0696 →
FCC0696-NTIA-1 ~ 40 → Select 

• Learn List Mode Data 
• List Mode ‘On’ 

• ARB ‘On’ config → ARB 
• Execute Trigger 
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次のトライアルのために新たな RFリストをリロード

Reloading a new RF list for the next trial 
 

• 保持 Keep config → List Mode 
• List Mode State ‘Off’ 
• List Mode Data → Select List 
• Learn List Mode Data 
• List Mode ‘On’ 

• config → ARB 
• Execute Trigger 
 

‘Learn List Mode Data’は、RF’ON’と適切なベースバンドセットアップで実行されなければなりま
せん。ラーニングシーケンス中に VSGが内部測定を実行するからです。ラーニング測定値は、
設定した周波数、レベル、およびベースバンドモードにだけ関連します。これらのパラメータのうち

1つでも変更すると、ラーニング測定値が無効になります。

The list learning must be done with the RF signal enabled and the baseband properly 
setup. This is required because the VSG performs internal measurement during the 
learning sequence. The learned values are only valid for the set frequency, level and 
baseband mode. Changing one of these parameters makes the learned values invalid. 
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16. テスト信号の確認 Checking the Test Signals 
 
Static Type

• Burst Interval 

Pulse Width 

PRI, 1/PRF 

18 Pulses per Burst 

15 s Burst Repetition Interval 

→ t

→ t
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• 18 Pulses per Burst (W53 Static Type 1) 
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• Pulse Width (W53 Static Type 1) 
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Varied Type (W56 Varied Type 4) 

 

• Burst Interval 

1~5 us 

150~230 us 

23~29 Pulses per Burst 

15 s Burst Repetition Interval 

→ t

→ t

1~5 us 

150~230 us 

23~29 Pulses per Burst 

→ t

1~5 us 

150~230 us 

23~29 Pulses per Burst 
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• 23 ~ 29 Pulses per Burst (W56 Varied Type 4) 
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• 1 ~ 5 us Pulse Width (W56 Varied Type 4) 
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FM Chirp Type

• 10 Bursts 

12 s / (8 ~ 20) 
= 0.6 ~ 1.5 s 

Burst Repetition Interval 

→ t

Constant 12 s 

8 ~ 20 bursts 
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• 1 ~ 3 Pulses per Burst 
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• FM Chirp 5 ~ 20 MHz Deviation, 50 ~ 100 us Pulse Width 
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Frequency Hopping Type

• 0.3 s burst within 40 MHz IF filter 

1 us 

Hop 1 
3 ms 

→ t

→ t

333 us 

0.3 s burst 

Hop 2 Hop 3 Hop 100 
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• 30 hops within 40 MHz IF filter 
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• 9 Pulses per Hop 
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• 1 us Pulse Width 
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• Hopping 
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